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foreword


  I started programming games in 1982. It wasn’t easy. We had no internet. Resources were limited to a handful of mostly terrible books and magazines that offered fascinating but confusing code fragments, and as for game engines—well, there weren’t any! Coding games was a massive uphill battle.


  How I envy you, reader, holding the power of this book in your hands. The Unity engine has done so much to open game programming up to so many people. Unity has managed to strike an excellent balance by being a powerful, professional game engine that’s still affordable and approachable for someone just getting started.


  Approachable, that is, with the right guidance. I once spent time in a circus troupe run by a magician. He was kind enough to take me in and helped guide me toward becoming a good performer. “When you stand on a stage,” he pronounced, “you make a promise. And that promise is ‘I will not waste your time.’”


  What I love most about Unity in Action is the “action” part. Joe Hocking wastes none of your time and gets you coding fast—and not just nonsense code, but interesting code that you can understand and build from, because he knows you don’t just want to read his book, and you don’t just want to program his examples—you want to be coding your own game.


  And with his guidance, you’ll be able to do that sooner than you might expect. Follow Joe’s steps, but when you feel ready, don’t be shy about diverging from his path and breaking out on your own. Skip to what interests you most—try experiments, be bold and brave! You can always return to the text if you get too lost.


  But let’s not dally in this foreword—the entire future of game development is impatiently waiting for you to begin! Mark this day on your calendar, for today is the day that everything changed. It will be forever remembered as the day you started making games.


  —Jesse Schell, CEO of Schell Games, Author of The Art of Game Design


  
preface


  I’ve been programming games for quite some time, but started using Unity only relatively recently. Unity didn’t exist when I first started developing games; the first version was released in 2005. Right from the start, it had a lot of promise as a game development tool, but it didn’t come into its own until several versions later. In particular, platforms like iOS and Android (collectively referred to as mobile) didn’t emerge until later, and those platforms factor heavily into Unity’s growing prominence.


  Initially, I viewed Unity as a curiosity, an interesting development tool to keep an eye on but not actually use. During that time, I was programming games for both desktop computers and websites and doing projects for a range of clients. I was using tools like Blitz3D and Adobe Flash, which were great to program in but were limiting in a lot of ways. As those tools started to show their age, I kept looking for better ways to develop games.


  I started experimenting with Unity around version 3 and then completely switched to it for my development work at Synapse Games. At first, I worked for Synapse on web games, but we eventually moved over to mobile games. And then we came full circle because Unity enabled us to deploy to the web in addition to mobile, all from one codebase!


  I’ve always seen sharing knowledge as important and have taught game development for several years. A large part of why I do this is the example set by my many mentors and teachers. (Incidentally, you may even have heard of one of my teachers because he was such an inspiring person: Randy Pausch delivered “The Last Lecture” shortly before he passed away in 2008.) I’ve taught classes at several schools and have always wanted to write a book about game development.


  In many ways, what I’ve written here is the book I wish had existed back when I was first learning Unity. Among Unity’s many virtues is a huge treasure trove of learning resources, but those resources tend to take the form of unfocused fragments (like the script reference or isolated tutorials) and require much digging to find what you need. Ideally, I’d have a book that wrapped up everything I needed to know in one place and presented it in a clear and logical manner, so now I’m writing such a book for you. I’m targeting people who already know how to program but who are newcomers to Unity, and possibly new to game development in general. The choice of projects reflects my experience of gaining skills and confidence by doing a variety of freelance projects in rapid succession.


  In learning to develop games using Unity, you’re setting out on an exciting adventure. For me, learning how to develop games meant putting up with a lot of hassle. You, on the other hand, have the advantage of a single coherent resource to learn from: this book!


  
acknowledgments


  I would like to thank Manning Publications for giving me the opportunity to write this book. The editors I worked with, including Robin de Jongh and especially Dan Maharry, helped me throughout this undertaking, and the book is much stronger for their feedback. Becky Whitney took over as primary editor for this third edition, while Candace West filled that role on the second edition. My sincere thanks also to the many others who worked with me during the development and production of the book: Deirdre Hiam, the project editor; Sharon Wilkey, the copyeditor; Jason Everett, the proofreader; and Mihaela Batinić, the reviewing editor.


  My writing benefited from the scrutiny of reviewers every step of the way. Thanks to Aharon Sharim Rani, Alain Couniot, Alain Lompo, Alberto Simões, Bradley Irby, Brent Boylan, Chris Lundberg, Cristian Antonioli, David Moskowitz, Erik Hansson, Francesco Argese, Hilde Van Gysel, James Matlock, Jan Kroken, John Ackley, John Guthrie, Jose San Leandro, Joseph W. White, Justin Calleja, Kent R. Spillner, Krishna Chaitanya Anipindi, Martin Tidman, Max Weinbrown, Nenko Ivanov Tabakov, Nick Keers, Owain Williams, Robert Walsh, Satej Kumar Sahu, Scott Chaussée, and Walter Stoneburner. Special thanks to the notable review work by technical development editor Scott Chaussee and by technical proofreader Christopher Haupt. René van den Berg and Shiloh Morris stepped into those roles for the second edition, while René was technical proofreader on the third edition and Robin Dewson did the tech edit. And I also want to thank Jesse Schell for writing the foreword to my book.


  Next, I’d like to recognize the people who’ve made my experience with Unity a fruitful one. That, of course, starts with Unity Technologies, the company that makes Unity (the game engine). I am also indebted to the community at the Game Development site on Stack Exchange (https://gamedev.stackexchange.com); while writing the first edition, I visited that QA site almost daily to learn from others and to answer questions. And the biggest push for me to use Unity came from Alex Reeve, my boss at Synapse Games. Similarly, I’ve picked up tricks and techniques from my coworkers, in both that and every job I’ve held since, and they all show up in the code I write.


  Finally, I want to thank my wife, Virginia, for her support during the time I was writing the book. Until I started working on it, I never really understood how much a book project takes over your life and affects everyone around you. Thank you so much for your love and encouragement.


  
about this book


  
Who should read this book


  Unity in Action, Third Edition is a book about programming games in Unity. Think of it as an intro to Unity for experienced programmers. The goal of this book is straightforward: to take people who have some programming experience, but no experience with Unity, and teach them how to develop a game by using Unity.


  The best way of teaching development is through example projects, with students learning by doing, and that’s the approach this book takes. I’ll present topics as steps toward building sample games, and you’ll be encouraged to build these games in Unity while exploring the book. We’ll go through a selection of projects every few chapters, rather than one monolithic project developed over the entire book. (Sometimes other books take the “one monolithic project” approach, but that can make it hard to jump into the middle if the early chapters aren’t relevant to you.)


  This book has more rigorous programming content than most Unity books (especially beginners’ books). Unity is often portrayed as a list of features with no programming required, which is a misleading view that won’t teach people what they need to know in order to produce commercial titles. If you don’t already know how to program a computer, I suggest going to one of the various “free interactive coding lessons” websites (https://learnprogramming.online, for example) and then coming back to this book after learning how to program.


  Don’t worry about the exact programming language; C# is used throughout this book, but skills from other languages will transfer quite well. Although the first part of the book takes its time introducing new concepts and will carefully and deliberately step you through developing your first game in Unity, the remaining chapters move a lot faster in order to take you through projects in multiple game genres. The book ends with a chapter describing deployment to various platforms including the web and mobile, but the main thrust of the book doesn’t make any reference to the ultimate deployment target because Unity is wonderfully platform-agnostic.


  As for other aspects of game development, extensive coverage of art disciplines would water down how much the book can cover and would be largely about software external to Unity (for example, the animation software used). Discussion of art tasks will be limited to aspects specific to Unity or that all game developers should know. (Note, though, that appendix C is about modeling custom objects.)


  
How this book is organized: A roadmap


  Chapter 1 introduces you to Unity, the cross-platform game development environment. You’ll learn about the fundamental component system underlying everything in Unity, as well as how to write and execute basic scripts.


  Chapter 2 progresses to writing a demo of movement in 3D, covering topics like mouse and keyboard input. Defining and manipulating both 3D positions and rotations are thoroughly explained.


  Chapter 3 turns the movement demo into a first-person shooter, teaching you raycasting and basic AI. Raycasting (shooting a line into the scene and seeing what it intersects) is a useful operation for all sorts of games.


  Chapter 4 covers importing and creating art assets. This is the one chapter of the book that does not focus on code, because every project needs (basic) models and textures.


  Chapter 5 teaches you how to create a 2D puzzle game in Unity. Although Unity started exclusively for 3D graphics, it now has excellent support for 2D graphics.


  Chapter 6 expands the 2D game explanations with platform game mechanics. In particular, we’ll implement controls, physics, and animation for the player.


  Chapter 7 introduces you to the latest GUI functionality in Unity. Every game needs a UI, and the latest versions of Unity feature an improved system for creating UIs.


  Chapter 8 shows how to create another movement demo in 3D, seen only from the third-person perspective this time. Implementing third-person controls will demonstrate key 3D math operations, and you’ll learn how to work with an animated character.


  Chapter 9 goes over how to implement interactive devices and items within your game. The player will have multiple ways of operating these devices, including touching them directly, touching triggers within the game, or pressing a button on the controller.


  Chapter 10 covers how to communicate with the internet. You’ll learn how to send and receive data by using standard internet technologies, like HTTP requests to get XML or JSON data from a server.


  Chapter 11 teaches how to program audio functionality. Unity has great support for both short sound effects and long music tracks; both sorts of audio are crucial for almost all video games.


  Chapter 12 walks you through bringing together pieces from different chapters into a single game. In addition, you’ll learn how to program point-and-click controls and how to save the player’s game.


  Chapter 13 goes over building the final app, with deployment to multiple platforms like desktop, web, mobile, and even VR. Unity enables you to create games for every major gaming platform!


  Four appendixes provide additional information about scene navigation, external tools, Blender, and learning resources.


  
About the code


  All the source code in the book, whether in code listings or snippets, is in a fixed-width font like this, which sets it off from the surrounding text. In most listings, the code is annotated to point out key concepts. The code is formatted so that it fits within the available page space in the book by adding line breaks and using indentation carefully.


  The only software required is Unity; this book uses Unity 2020.3.12, which is the current default release as I write this. Certain chapters do occasionally discuss other pieces of software, but those are treated as optional extras and not core to what you’re learning.


  WARNING Unity projects remember which version of Unity they were created in and will issue a warning if you attempt to open them in a different version. If you see that warning while opening this book’s sample downloads, click Continue and ignore it.


  The code listings sprinkled throughout the book generally show what to add or change in existing code files; unless it’s the first appearance of a given code file, don’t replace the entire file with subsequent listings. Although you can download complete working sample projects to refer to, you’ll learn best by typing out the code listings and looking at the working samples only for reference. Those downloads are available from the publisher’s website (https://www.manning.com/books/unity-in-action-third-edition) and on GitHub (https://github.com/jhocking/uia-3e).


  
liveBook discussion forum


  Purchase of Unity in Action, Third Edition, includes free access to liveBook, Manning’s online reading platform. Using liveBook’s exclusive discussion features, you can attach comments to the book globally or to specific sections or paragraphs. It’s a snap to make notes for yourself, ask and answer technical questions, and receive help from the author and other users. To access the forum, go to https://livebook.manning.com/#!/book/unity-in-action-third-edition/discussion. You can also learn more about Manning's forums and the rules of conduct at https://livebook.manning.com/#!/discussion.


  Mannings’s commitment to our readers is to provide a venue where a meaningful dialogue between individual readers and between readers and the author can take place. It is not a commitment to any specific amount of participation on the part of the author, whose contribution to the forum remains voluntary (and unpaid). We suggest you try asking the author some challenging questions lest his interest stray! The forum and the archives of previous discussions will be accessible from the publisher’s website as long as the book is in print.


  
about the author


  Joe Hocking is a software engineer who specializes in interactive media development. He currently works for Qualcomm, wrote most of the third edition while working for BUNDLAR, and wrote the first edition while at Synapse Games. He has also taught classes at the University of Illinois Chicago, the School of the Art Institute of Chicago, and Columbia College Chicago. He lives in the Chicago suburbs with his wife and two kids. His website is www.newarteest.com.


  
about the cover illustration


  The figure on the cover of Unity in Action, Third Edition is captioned “Habit of the Master of Ceremonies of the Grand Signior.” The Grand Signior was another name for a sultan of the Ottoman Empire. The illustration is taken from A Collection of the Dresses of Different Nations, Ancient and Modern by Thomas Jefferys, published in London between 1757 and 1772. The title page states that these are hand-colored copperplate engravings, heightened with gum arabic. Jefferys (1719-1771) was called “Geographer to King George III.” An English cartographer who was the leading map supplier of his day, Jefferys engraved and printed maps for government and other official bodies and produced a wide range of commercial maps and atlases, especially of North America. His work as a mapmaker sparked an interest in local dress customs of the lands he surveyed, which are brilliantly displayed in this four-volume collection.


  Fascination with faraway lands and travel for pleasure were relatively new phenomena in the late 18th century, and collections such as this one were popular, introducing the tourist as well as the armchair traveler to the inhabitants of other countries. The diversity of the drawings in Jefferys’s volumes speaks vividly of the uniqueness and individuality of the world’s nations some 200 years ago. Dress codes have changed since then, and the diversity by region and country, so rich at the time, has faded away. It is now hard to tell the inhabitant of one continent apart from another. Perhaps, trying to view it optimistically, we have traded a cultural and visual diversity for a more varied personal life, or a more varied and interesting intellectual and technical life.


  At a time when it is hard to tell one computer book from another, Manning celebrates the inventiveness and initiative of the computer business with book covers based on the rich diversity of regional life of two centuries ago, brought back to life by Jefferys’s pictures.


  
Part 1 First steps


  It’s time to take your first steps in using Unity. If you don’t know anything about Unity, that’s okay! I’m going to start by explaining what Unity is, including the fundamentals of how to program games in it. Then we’ll walk through a tutorial about developing a simple game in Unity. This first project will teach you several specific game development techniques, as well as give you a good overview of how the process works. Onward to chapter 1!


  
1 Getting to know Unity


  This chapter covers


  
    	
      What makes Unity a great choice

    


    	
      Operating the Unity editor

    


    	
      Programming in Unity

    

  


  If you’re anything like me, you’ve had developing a video game on your mind for a long time. But it’s a big jump from playing games to making them. Numerous game development tools have appeared over the years, and we’re going to discuss one of the most recent and most powerful of these tools.


  Unity is a professional-quality game engine used to create video games targeting a variety of platforms. It’s not only a professional development tool used daily by thousands of seasoned game developers, but also one of the most accessible modern tools for novice game developers. Until recently, a newcomer to game development would face lots of imposing barriers right from the start, but Unity makes it easy to start learning these skills.


  Because you’re reading this book, chances are you’re curious about computer technology and have either developed games with other tools or built other kinds of software, such as desktop applications or websites. Creating a video game isn’t fundamentally different from writing any other kind of software; it’s mostly a difference of degree. For example, a video game is a lot more interactive than most websites, and thus involves different sorts of code, but the skills and processes involved in creating both are similar.


  If you’ve already cleared the first hurdle on your path to learning game development, having learned the fundamentals of programming software, then your next step is to pick up some game development tools and translate that programming knowledge into the realm of gaming. Unity is a great choice of game development environment to work with.


  
    A warning about terminology


    This book is about programming in Unity and is therefore primarily of interest to coders. Although many other resources discuss different aspects of game development and Unity, in this book programming takes front and center.


    



    Incidentally, note that the word developer may have an unfamiliar meaning in the context of game development: developer is a synonym for programmer in disciplines like web development, but in game development, developer often refers to anyone who works on a game, and programmer is a specific role within that. Other kinds of game developers are artists and designers, but this book focuses on programming.

  


  To start, go to www.unity.com to learn more about the software. Although Unity’s original focus was on 3D games, Unity works great for 2D games as well, and this book covers both. Indeed, even when demonstrated on a 3D project, many topics (saving data, playing audio, and so on) apply to both. Section 1.2 will walk you through installing Unity as a newcomer, but first let’s discuss specific reasons to choose this tool.


  
1.1 Why is Unity so great?


  Let’s take a closer look at that description from the beginning of the chapter: Unity is a professional-quality game engine used to create video games targeting a variety of platforms. That’s a fairly straightforward answer to the straightforward question “What is Unity?” But what exactly does that answer mean, and why is Unity so great?


  
1.1.1 Unity’s strengths and advantages


  Game engines provide a plethora of features that are useful across many games. A game implemented using a particular engine will get all those features, while adding custom art assets and gameplay code specific to that game. Unity has physics simulation, normal maps, screen space ambient occlusion (SSAO), dynamic shadows . . . and the list goes on. Many game engines boast such features, but Unity has two main advantages over similar cutting-edge game development tools: an extremely productive visual workflow and a high degree of cross-platform support.


  The visual workflow is a fairly unique design, different from most other game development environments. Whereas other game development tools are often a complicated mishmash of disparate parts that must be wrangled, or perhaps a programming library that requires you to set up your own integrated development environment (IDE), build-chain, and whatnot, the development workflow in Unity is anchored by a sophisticated visual editor.


  The editor is used to lay out the scenes in your game and to tie together art assets and code into interactive objects. The beauty of this editor is that it enables professional-quality games to be built quickly and efficiently, giving developers tools to be incredibly productive, while still using an extensive list of the latest technologies in video gaming.


  NOTE Most other game development tools that have a central visual editor are also saddled with limited and inflexible scripting support, but Unity doesn’t suffer from that disadvantage. Although everything created for Unity ultimately goes through the visual editor, this core interface can be used to link projects to custom code that runs in Unity’s game engine. Experienced programmers shouldn’t dismiss this development environment, mistaking it for some click-together game creator with limited programming capability!


  The editor is especially helpful for doing rapid iteration, honing the game through cycles of prototyping and testing. You can adjust objects in the editor and move things around even while the game is running. Plus, Unity allows you to customize the editor itself by writing scripts that add new features and menus to the interface.


  Besides the editor’s significant productivity advantages, the other main strength of Unity’s tool set is a high degree of cross-platform support. Not only is Unity multiplatform in terms of deployment targets (you can deploy to PC, web, mobile, or consoles), but it’s also multiplatform in terms of development tools (you can develop a game on Microsoft Windows or Apple macOS). This platform-agnostic nature is largely because Unity started as Mac-only software and was later ported to Windows. The first version launched in 2005 and initially supported only Mac, but within months Unity had been updated to work on Windows as well.


  Successive versions gradually added more deployment platforms, such as a cross-platform web player in 2006, iPhone in 2008, Android in 2010, and even game consoles like Xbox and PlayStation. More recently, Unity has added deployment to WebGL, the new framework for graphics in web browsers, and even has support for extended reality (XR)—both virtual reality (VR) and augmented reality (AR)—platforms like Oculus and VIVE. Few game engines support as many deployment targets as Unity, and none make deploying to multiple platforms so simple.


  In addition to these main strengths, a third, more subtle, benefit comes from the modular component system used to construct game objects. In a component system, components are mix-and-match packets of functionality, and objects are built up as a collection of components, rather than as a strict hierarchy of classes. A component system is a different (and usually more flexible) approach to object-oriented programming (OOP) that constructs game objects through composition rather than inheritance. Figure 1.1 diagrams an example comparison.
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  Figure 1.1 Inheritance versus composition


  In a component system, objects exist on a flat hierarchy, and different objects have different collections of components. An inheritance structure, in contrast, has different objects on completely different branches of the tree. The component arrangement facilitates rapid prototyping, because you can quickly mix and match components rather than having to refactor the inheritance chain when objects change.


  Although you could write code to implement a custom component system if one didn’t exist, Unity already has a robust component system, and this system is even integrated with the visual editor. Instead of being able to manipulate components only in code, you can attach and detach components within the visual editor. Meanwhile, you aren’t limited to building objects only through composition; you still have the option of using inheritance in your code, including all the best-practice design patterns that have emerged based on inheritance.


  
1.1.2 Downsides to be aware of


  Unity has many advantages that make it a great choice for developing games, and I highly recommend it, but I’d be remiss if I didn’t mention its weaknesses. In particular, the combination of the visual editor and sophisticated coding, though very effective with Unity’s component system, is unusual and can create difficulties. In complex scenes, you can lose track of which objects in the scene have specific components attached. Unity does provide a search feature for finding attached scripts, but it could be more robust; sometimes you still encounter situations requiring you to manually inspect everything in the scene in order to find script linkages. This doesn’t happen often, but when it does happen, it can be tedious.


  Another disadvantage that can be surprising and frustrating for experienced programmers is that linking in external code libraries can be difficult. Old versions of Unity didn’t support external code libraries at all actually, so they had to be manually copied into every project. Now Unity comes with the Package Manager, and libraries (or packages) are referenced from a central shared location. These packages work great for optional functionality provided by Unity itself (Unity doesn’t automatically include functionality that you don’t need in every single project), and future chapters will occasionally have you installing packages for things like advanced font handling. Creating your own packages can be tricky, however, making it awkward to share code among multiple projects. You may find it simpler to just manually copy code between projects and deal with any version mismatches down the road, which is not an ideal trade-off to be making.


  NOTE Difficulty working with version-control systems (such as Git or Subversion) used to be a significant weakness of Unity, but more recent versions work fine. You may find out-of-date resources telling you that Unity doesn’t work with version control, but newer resources describe which files and folders in a project need to be put in the repository and which don’t. To start out, read Unity’s documentation (http://mng.bz/BbhD) or look at the .gitignore file maintained by GitHub (http://mng.bz/g7nl).


  A third weakness has to do with the sometimes dizzying array of options. Unity offers multiple approaches to some functionalities, and it is not always clear which approach you should use. To a certain extent, that situation is inevitable for a tool under active development, but still results in confusion and discomfort for users. This evolutionary messiness can bewilder even Unity veterans, so newcomers to Unity will definitely face confusion at times. This book highlights such features and offers guidance.


  For example, chapter 7 explains how to develop a user interface (UI) for Unity games. Well, Unity actually has three UI systems (which are compared at http:// mng.bz/r60X) because of successively developed systems that improve on their predecessor. This book covers the second UI system (Unity UI, or uGUI) because it is still preferred over the incomplete third UI system (UI Toolkit), but I wouldn’t be surprised if UI Toolkit matures to production-ready within a few years. In the interim, newcomers may have difficulty deciding on a UI approach.


  
1.1.3 Example games built with Unity


  You’ve heard about the pros and cons of Unity, but you might still need convincing that its development tools can give first-rate results. Visit the Unity gallery at https://unity.com/case-study to see a constantly updated list of games and simulations developed using Unity. This section explores a handful of games, showcasing multiple genres and deployment platforms. All game titles are trademarks of their respective game companies, and screenshots are also copyrighted to those companies, with all rights reserved.


  Desktop (Windows, Mac, Linux) and Console (PlayStation, Xbox, Switch)


  Because the Unity editor runs on the same platform, deployment to Windows or Mac is often the most straightforward target platform. Meanwhile, console games developed in Unity are often released on PC too, thanks to Unity’s easy cross-platform deployment. Here are a couple of examples of desktop and console games in different genres:


  
    	
      Fall Guys (figure 1.2), a chaotic 3D action game developed by Mediatonic (trademarks of Mediatonic Limited)
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  Figure 1.2 Fall Guys


  
    	
      Cuphead (figure 1.3), a 2D platformer developed by Studio MDHR
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  Figure 1.3 Cuphead


  Mobile (iOS and Android)


  Unity can also deploy games to mobile platforms like iOS (iPhones and iPads) and Android (phones and tablets). Here are three examples of mobile games in different genres:


  
    	
      Monument Valley 2 (figure 1.4), a puzzle game developed by ustwo
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  Figure 1.4 Monument Valley 2


  
    	
      Guns of Boom (figure 1.5), a first-person shooter developed by Game Insight
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  Figure 1.5 Guns of Boom


  
    	
      Animation Throwdown (figure 1.6), a collectible card game developed by Kongregate
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  Figure 1.6 Animation Throwdown


  Virtual Reality (Oculus, VIVE, PlayStation VR)


  Unity can even deploy to XR platforms, including virtual reality headsets. Here are a couple of examples of VR games in different genres:


  
    	
      Beat Saber (figure 1.7), a rhythm game developed by Beat Games
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  Figure 1.7 Beat Saber


  
    	
      I Expect You to Die (figure 1.8), an escape puzzle game developed by Schell Games
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  Figure 1.8 I Expect You to Die


  As you can see from these examples, Unity’s strengths can definitely translate into commercial-quality games. But even with Unity’s significant advantages over other game development tools, newcomers may misunderstand the involvement of programming in the development process.


  Unity is often portrayed as a list of features with no programming required, which is a misleading view that won’t teach people what they need to know in order to produce commercial titles. Though it’s true that you can click together a fairly elaborate prototype using preexisting components even without a programmer being involved (which is itself a pretty big feat), rigorous programming is required to move beyond an interesting prototype to a polished game ready for release.


  
1.2 How to use Unity


  The previous section talked a lot about the productivity benefits of Unity’s visual editor, so let’s go over what the interface looks like and how it operates. If you haven’t already done so, download the program by going to www.unity.com and clicking Get Started. Here you will see a breakdown of the various subscription plans offered. Everything in this book works in the free version, so select the Individual tab and click the button under the free Personal edition. The paid versions of Unity differ mainly in commercial licensing terms, not in underlying functionality.


  The website has separate downloads for new and returning users. The difference is simply that the download for new users will launch into a software wizard that directs users to intro tutorials, whereas the download for returning users goes straight to the main application with no introduction. So even if you are new to Unity, get the download for returning users and skip the intro content (it’s redundant with this book, after all).


  You’ll actually download a lightweight installation manager rather than the main Unity application. This manager application, called Unity Hub, exists to simplify the installation and use of multiple versions of Unity simultaneously. As shown in figure 1.9, installing the editor will be the first thing that happens when you launch Unity Hub. Install whichever is the default Recommended Release; this book uses Unity 2020.3.12 (the current default release as of this writing). If you later want to install additional versions of Unity (newer versions than the default are available), click Installs on the side menu in Unity Hub.
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  Figure 1.9 Unity Hub on first launch versus subsequently


  TIP By the time you read this, newer Unity versions will likely have been released. Advanced features will have changed, and possibly even the look of the interface could be different, but the fundamental concepts covered by this book will still be true. The explanations given in this book will generally still apply to whichever future version of Unity is current.


  WARNING Projects remember which version of Unity they were created in and will issue a warning if you attempt to open them in a different version. Sometimes it doesn’t matter (for example, ignore the warning if it appears while opening this book’s sample downloads), but sometimes you don’t want to open a project in the wrong version.


  Continuing on from installing the editor, go to the Learn tab to download a first project. Select any project to look around in (you won’t be doing much with it anyway) but note that figure 1.10 shows Karting. Unity will download and launch the selected project. You may see a warning message about importing files to set up the new project; realize that the import can take several minutes.


  Once the new project is finally loaded, choose Load Scene to dismiss the initial pop-up. If it isn’t already open, navigate to Assets/Karting/Scenes/ in the file browser at the bottom of the editor, and double-click MainScene (scene files have the Unity cube icon). You should see a screen similar to figure 1.10.
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  Figure 1.10 Parts of the interface in Unity


  The interface in Unity is split into sections: the Scene tab, the Game tab, the Toolbar, the Hierarchy tab, the Inspector, the Project tab, and the Console tab. Each section has a different purpose, but all are crucial to the game-building life cycle:


  
    	
      You can browse through all the files in the Project tab.

    


    	
      You can position objects in the current scene by using the Scene tab.

    


    	
      The Toolbar has controls for working with the scene.

    


    	
      You can drag and drop object relationships in the Hierarchy tab.

    


    	
      The Inspector lists information about selected objects, including linked code.

    


    	
      You can test playing in Game view while watching error output in the Console tab.

    

  


  This is the default layout in Unity; all of the views are in tabs and can be moved around or resized, docking in different places on the screen. Later, you can play around with customizing the layout, but for now, the default layout is the best way to understand what all the views do.


  
1.2.1 Scene view, Game view, and the Toolbar


  The most prominent part of the interface is the Scene view in the middle. This is where you can see what the game world looks like and move objects around. Mesh objects in the scene appear as, well, their mesh (defined in a moment). You can also see other objects in the scene, represented by icons and colored lines: cameras, lights, audio sources, collision regions, and so forth. Note that the view you’re seeing here isn’t the same as the view in the running game—you’re able to look around the scene at will without being constrained to the game’s view.


  DEFINITION A mesh object is a visual object in space. Visuals in 3D graphics are constructed out of lots of connected lines and shapes—hence the word mesh.


  The Game view isn’t a separate part of the screen but rather another tab located right next to Scene (look for tabs at the top left of views). A couple of places in the interface have multiple tabs like this; if you click a different tab, the view is replaced by the new active tab. When the game is running, what you see in this view is the game. It isn’t necessary to manually switch tabs every time you run the game, because the view automatically switches to Game when the game starts.


  TIP While the game is running, you can switch back to the Scene view, allowing you to inspect objects in the running scene. This capability is extremely useful for seeing what’s going on while the game is running and is a helpful debugging tool that isn’t available in most game engines.


  Speaking of running the game, that’s as simple as clicking the Play button just above the Scene view. That whole top section of the interface is referred to as the Toolbar, and Play is located right in the middle. Figure 1.11 breaks apart the full editor interface to show only the Toolbar at the top as well as the Scene/Game tabs right underneath.
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  Figure 1.11 Editor screenshot cropped to show Toolbar, Scene, and Game


  At the left side of the Toolbar are buttons for scene navigation and transforming objects—to look around the scene and to move objects. I suggest you spend time practicing these, because they are two of the most important activities you’ll do in Unity’s visual editor. (They’re so important that they get their own section following this one.)


  The right-hand side of the Toolbar is where you’ll find drop-down menus for layouts and layers. As mentioned earlier, the layout of Unity’s interface is flexible, so the Layout menu allows you to switch layouts. As for the Layers menu, that’s advanced functionality that you can ignore for now (layers are mentioned in future chapters).


  
1.2.2 The mouse and keyboard


  Scene navigation is primarily done using the mouse, along with a few modifier keys used to change what the mouse is doing. The three main navigation maneuvers are Move, Orbit, and Zoom. The specific mouse movements vary depending on the mouse you’re using and are described in appendix A. The three movements involve clicking and dragging while holding down a combination of Alt (or Option on Mac) and Ctrl (Command on a Mac). Spend a few minutes moving around in the scene to understand what Move, Orbit, and Zoom do.


  TIP Although Unity can be used with one- or two-button mice, I highly recommend getting a three-button mouse (and yes, a three-button mouse works fine on a Mac).


  Transforming objects is also done through three main maneuvers, and the three scene navigation moves are analogous to the three transforms: Translate, Rotate, and Scale (figure 1.12 demonstrates the transforms on a cube).
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  Figure 1.12 Applying the three transforms: Translate, Rotate, and Scale. (The lighter lines are the previous state of the object before it was transformed.)


  When you select an object in the scene, you can then move it around (the mathematically accurate technical term is translate), rotate it, and scale its size. Relating back to scene navigation maneuvers, Move corresponds to Translate for the camera, Orbit corresponds to Rotate, and Zoom corresponds to Scale. Besides the buttons on the Toolbar, you can switch these functions by pressing W, E, or R on the keyboard. When you activate a transform, you’ll notice that a set of color-coded arrows or circles appears over the object in the scene; this is the Transform gizmo, and you can click and drag this gizmo to apply the transformation.


  A fourth tool is next to the transform buttons. Called the Rect tool, it’s designed for use with 2D graphics. This one tool combines movement, rotation, and scaling. Similarly, the fifth button is for a tool that combines movement, rotation, and scaling for 3D objects. Personally, I prefer to manipulate the three transforms separately, but you may find the combined tools more convenient.


  Unity has a host of other keyboard shortcuts for speeding up a variety of tasks. Refer to appendix A to learn about them. And with that, on to the remaining sections of the interface!


  
1.2.3 The Hierarchy view and the Inspector panel


  Looking at either side of the screen, you’ll see the Hierarchy tab on the left and the Inspector tab on the right (see figure 1.13). Hierarchy lists the name of every object in the scene and nests the names together according to their hierarchy linkages in the scene. Basically, it’s a way of selecting objects by name instead of hunting them down and clicking them within the Scene view. The Hierarchy linkages group objects together visually, like folders, allowing you to move the entire group as one.
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  Figure 1.13 Editor screenshot cropped to show the Hierarchy and Inspector tabs


  The Inspector shows you information about the currently selected object. Select an object, and the Inspector is then filled with information about that object. The information shown is pretty much a list of components, and you can even attach or remove components from objects. All game objects have at least one component, Transform, so you’ll always see at least information about positioning and rotation in the Inspector. Often, objects will have several components listed here, including scripts attached to them.


  
1.2.4 The Project and Console tabs


  At the bottom of the screen, you’ll see Project and Console (see figure 1.14). As with Scene and Game, these aren’t two separate portions of the screen, but rather tabs that you can switch between.


  Project shows all the assets (art, code, and so on) in the project. Specifically, on the left side of the view is a listing of the project’s directories; when you select a directory, the right side of the view shows the individual files in that directory. The directory listing in Project is similar to the list view in Hierarchy, but Hierarchy shows objects in the scene; Project shows files that may not be contained within any specific scene (including scene files—when you save a scene, it shows up in Project!).
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  Figure 1.14 Editor screenshot cropped to show the Project and Console tabs


  TIP Project view mirrors the Assets directory on disk, but generally, you shouldn’t move or delete files directly by going to the Assets folder in your OS’s file explorer. If you do those things within the Project view, Unity will keep in sync with that folder.


  The Console tab is the place where messages from the code show up. Some of these messages will be debugging output that you placed deliberately, but Unity also emits error messages if it encounters problems in the script you wrote.


  
1.3 Getting up and running with Unity programming


  Now let’s look at how the process of programming works in Unity. Although art assets can be laid out in the visual editor, you need to write code to control them and make the game interactive. Complex programming in Unity is done using C# as the programming language.


  Launch Unity and create a new project: choose New in Unity Hub, or choose File > New Project if Unity is already running. Type a name for the project, leave the default 3D template (future chapters mention 2D), and then choose where you want to save the project. A Unity project is simply a directory full of various asset and settings files, so save the project anywhere on your computer. Click Create, and then Unity will briefly disappear while it sets up the project directory.


  Alternatively, you could open the chapter 1 sample project. I strongly recommend you try to follow the upcoming instructions in a new project, and look at the finished sample only afterward to check your work, but it’s up to you. Choose Add in Unity Hub to add a downloaded project folder to the list and then click the project in the list.


  WARNING If you are opening the book’s sample project rather than creating a new project, Unity may emit the following message: Rebuilding Library because the asset database could not be found! This refers to the project’s Library folder; that folder contains files generated by Unity and used while working, but it is not necessary to distribute those files.


  When Unity reappears, you’ll be looking at a blank project. Next, let’s discuss how programs get executed in Unity.


  
1.3.1 Running code in Unity: Script components


  All code execution in Unity starts from code files linked to an object in the scene. Ultimately, this code execution is all part of the component system described earlier; game objects are built up as a collection of components, and that collection can include scripts to execute.


  NOTE Unity refers to the code files as scripts, using a definition of script that’s most commonly encountered with JavaScript running in a browser: the code is executed within the Unity game engine, as opposed to compiled code that runs as its own executable. But don’t get confused, because many people define the word differently; for example, scripts often refer to short, self-contained utility programs. Scripts in Unity are more akin to individual OOP classes, and scripts attached to objects in the scene are object instances.


  As you’ve probably surmised from this description, in Unity, scripts are components—not all scripts, mind you, only scripts that inherit from MonoBehaviour, the base class for script components. MonoBehaviour defines the invisible groundwork for attaching components to game objects, and (as shown in listing 1.1) inheriting from it provides a couple of automatically run methods that you can implement. Those methods include Start(), called once when the object becomes active (which is generally as soon as the scene with that object has loaded), and Update(), which is called every frame. Your code is run when you put it inside these predefined methods.


  DEFINITION A frame is a single cycle of the looping game code. Nearly all video games (not only in Unity, but video games in general) are built around a core game loop, where the code executes in a cycle while the game is running. Each cycle includes drawing the screen—hence the name frame (like the series of still frames of a movie).


  Listing 1.1 Code template for a basic script component

  using System.Collections;                    ❶
using System.Collections.Generic;
using UnityEngine;
public class HelloWorld : MonoBehaviour {    ❷
    void Start() {
        // do something once                 ❸
    }
    
    void Update() {
        // do something every frame          ❹
    }
}


  ❶ Include namespaces for Unity and .NET/Mono classes.


  ❷ The syntax for inheritance


  ❸ Put code here that runs once.


  ❹ Put code here that runs every frame.


  This is what the file contains when you create a new C# script: the minimal boilerplate code that defines a valid Unity component. Unity has a script template tucked away in the bowels of the application, and when you create a new script, Unity copies that template and renames the class to match the name of the file (which is HelloWorld.cs in my case). Unity also has empty shells for Start() and Update(), because those are the two most common places from which you’ll call your custom code.


  To create a script, select C# Script from the Create menu, which you access either under the Assets menu (note that Assets and GameObjects both have listings for Create, but they’re different menus) or by right-clicking in the Project view. Type in a name for the new script, such as HelloWorld. As explained later in the chapter (see figure 1.16), you’ll click and drag this script file onto an object in the scene. Double-click the script, and it’ll automatically be opened in another program for editing, as discussed next.


  
1.3.2 Using Visual Studio, the included IDE


  Programming isn’t done within Unity exactly, but rather code exists as separate files that you point Unity to. Script files can be created within Unity, but you still need to use a text editor or IDE to write all the code within those initially empty files. Unity comes with Microsoft Visual Studio, an IDE for C# (figure 1.15 shows what it looks like). You can visit https://visualstudio.microsoft.com to learn more about this software.
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  Figure 1.15 Parts of the interface in Visual Studio


  NOTE If Unity opens a different IDE than Visual Studio, you may want to switch the External Tools preference. Go to Preferences > External Tools > External Script Editor to select an IDE.


  NOTE Visual Studio organizes files into groupings called a solution. Unity automatically generates a solution that has all the script files, so you usually don’t need to worry about that.


  Various flavors of Visual Studio are available (many programmers prefer Visual Studio Code), or you could use an IDE from a completely different company, like JetBrains Rider. Switching to a different IDE is as simple as going to External Tools in Unity’s preferences. I generally use Visual Studio for Mac, but you could use a different IDE and not have any problems following along with this book. Beyond this introductory chapter, I’m not going to talk about the IDE.


  Always keep in mind that, although the code is written in Visual Studio, the code isn’t run there. The IDE is pretty much a fancy text editor, and the code is run when you click Play within Unity.


  
1.3.3 Printing to the console: Hello World!


  All right, you already have an empty script in the project, but you also need an object in the scene to attach the script to. Recall figure 1.1 depicting how a component system works; a script is a component, so it needs to be set as one of the components on an object.


  Choose GameObject > Create Empty, and a blank GameObject will appear in the Hierarchy list. Now drag the script from the Project view over to the Hierarchy view and drop it on the empty GameObject. As shown in figure 1.16, Unity will highlight valid places to drop the script, and dropping it on the GameObject will attach the script to that object.
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  Figure 1.16 How to link a script to a GameObject


  To verify that the script is attached to the object, select the GameObject and look at the Inspector view. You should see two components listed: the Transform component, which is the basic position/rotation/scale component all objects have and which can’t be removed, and below that, your script.


  NOTE Eventually, this action of dragging objects from one place and dropping them on other objects will feel routine. A lot of linkages in Unity, not only attaching scripts to objects, are created by dragging things on top of each other.


  When a script is linked to an object, you’ll see something like figure 1.17, with the script showing up as a component in the Inspector. Now the script will execute when you play the scene, although nothing is going to happen yet because you haven’t written any code. Let’s do that next!
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  Figure 1.17 Linked script being displayed in the Inspector


  Double-click the script to open it and get back to listing 1.1. The classic place to start when learning a new programming environment is having it print the text Hello World!, so add the line in the following listing inside the Start() method.


  Listing 1.2 Adding a console message

  ...
void Start() {
    Debug.Log("Hello World!");    ❶
}
...


  ❶ Add the logging command here.


  The Debug.Log() command prints a message to the Console view in Unity. Meanwhile, that line goes in the Start() method because, as was explained earlier, that method is called as soon as the object becomes active. Start() will be called once, as soon as you click Play in the editor. Once you’ve added the log command, save the script, click Play in Unity, and switch to the Console view. You’ll see the message Hello World! appear. Congratulations—you’ve written your first Unity script! Of course, the code will be more elaborate in later chapters, but this is an important first step.


  WARNING Always remember to save the file after making adjustments to a script! A pretty common mistake is to adjust the code and then immediately click Play in Unity without saving, resulting in the game still using the code from before you adjusted it.


  
    “Hello World!” steps in brief


    Let’s reiterate and summarize the steps from the last few pages:


    
      	
Create a new project.


      	
Create a new C# script.


      	
Create an empty GameObject.


      	
Drag the script onto the object.


      	
Add the log command to the script.


      	
Click Play!

    

  


  Now it’s time to save the scene; this creates a .unity file with the Unity icon. The scene file is a snapshot of everything currently loaded in the game so that you can reload this scene later. Saving this scene may hardly seem worthwhile because it’s so simple (a single empty GameObject)—but if you don’t save the scene, you’ll find it empty again when you come back to the project after quitting Unity.


  
    Errors in the script


    To see how Unity indicates errors, purposely put a typo in the HelloWorld script. For example, if you type an extra parenthesis symbol, an error message will appear in the Console tab with a red error icon.
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    A script error being displayed in the Console tab


    



    Get used to reading these error messages, because this will be your main way of solving problems in your code. Notice how the message is structured: it first indicates which file has the error, then shows a line number within that file, and finally provides a description of the error that occurred.

  


  
Summary


  
    	
      Unity is a multiplatform development tool.

    


    	
      Unity’s visual editor has several sections that work in concert.

    


    	
      Scripts are attached to objects as components.

    


    	
      Code is written inside scripts by using Visual Studio.

    

  


  
2 Building a demo that puts you in 3D space


  This chapter covers


  
    	
      Understanding 3D coordinate space

    


    	
      Putting a player in a scene

    


    	
      Writing a script that moves objects

    


    	
      Implementing FPS controls

    

  


  Chapter 1 concluded with the traditional “Hello World!” introduction to a new programming tool; now it’s time to dive into a nontrivial Unity project, a project with interactivity and graphics. You’ll put objects into a scene and write code to enable a player to walk around that scene. Basically, it’ll be Doom without the monsters (something like the depiction in figure 2.1). The visual editor in Unity enables new users to start assembling a 3D prototype right away, without needing to write a lot of boilerplate code first (for things like initializing a 3D view or establishing a rendering loop).
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  Figure 2.1 Screenshot of the 3D demo (basically, Doom without the monsters)


  It’s tempting to immediately start building the scene in Unity, especially with such a simple (in concept!) project. But it’s always a good idea to pause at the beginning and plan out what you’re going to do, and this is especially important right now because you’re new to the process.


  NOTE Remember, the project for every chapter can be downloaded from the book’s website (http://mng.bz/VBY5). First open the project in Unity and then open the main scene (usually just named Scene) to run and inspect. While you’re learning, I recommend you type out all the code yourself and use the downloaded sample only for reference.


  
2.1 Before you start . . .


  Unity makes it easy for a newcomer to get started, but let’s go over a couple of points before you build the complete scene. Even when working with a tool as flexible as Unity, you need to have a sense of the goal you’re working toward. You also need to grasp how 3D coordinates operate, or you could get lost as soon as you try to position an object in the scene.


  
2.1.1 Planning the project


  Before you start programming anything, you always want to pause and ask yourself, “So what am I building here?” Game design is a huge topic, with many impressively large books focused on how to design a game. Fortunately, for our purposes, you need only a brief outline of this simple demo in mind to develop a basic learning project. These initial projects won’t be terribly complex designs anyway, in order to avoid distracting you from learning programming concepts. You can (and should!) worry about higher-level design issues after you’ve mastered the fundamentals of game development.


  For this first project, you’ll build a basic first-person shooter (FPS) scene. We will create a room to navigate around, and players will see the world from their character’s point of view and can control the character by using the mouse and keyboard. All the interesting complexity of a complete game can be stripped away for now to concentrate on the core mechanics: moving around in a 3D space. Figure 2.2 depicts the road map for this project, laying out the checklist I built in my head:


  
    	
      Set up the room: create the floor, outer walls, and inner walls.

    


    	
      Place the lights and camera.

    


    	
      Create the player object (including attaching the camera on top).

    


    	
      Write movement scripts: rotate with the mouse and move with the keyboard.
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  Figure 2.2 Road map for the 3D demo


  Don’t be scared off by everything in this road map! It sounds like a lot of steps in this chapter, but Unity makes them easy. The upcoming sections about movement scripts are so extensive only because we’ll be going through every line so that you can understand all the concepts in detail.


  This project is a first-person demo in order to keep the art requirements simple; because you can’t see yourself, it’s fine for “you” to be a cylindrical shape with a camera on top! Now you need to understand how 3D coordinates work so that placing everything in the visual editor will be easy.


  
2.1.2 Understanding 3D coordinate space


  If you think about the simple plan we’re starting with, it has three aspects: a room, a view, and controls. All of these items rely on you understanding how positions and movements are represented in 3D computer simulations. If you’re new to working with 3D graphics, you might not already know this stuff.


  It all boils down to numbers that indicate points in space, and the way those numbers correlate to the space is through coordinate axes. If you think back to math class, you’ve probably seen and used x- and y-axes (see figure 2.3) for assigning coordinates to points on the page. This is referred to as a Cartesian coordinate system.
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  Figure 2.3 Coordinates along the x- and y-axes define a 2D point.


  Two axes give you 2D coordinates, with all points in the same plane. Three axes are used to define 3D space. Because the x-axis goes along the page horizontally and the y-axis goes along the page vertically, we now imagine a third axis that sticks straight into and out of the page, perpendicular to both the x- and y-axes. Figure 2.4 depicts the x-, y-, and z-axes for 3D coordinate space. Everything that has a specific position in the scene will have x-, y-, and z-coordinates: the position of the player, the placement of a wall, and so forth.
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  Figure 2.4 Coordinates along the x-, y-, and z-axes define a 3D point.


  In Unity’s Scene view, you can see these three axes displayed. In the Inspector, you can type in the three numbers required to position an object. You will not only write code to position objects using these three-number coordinates, but also define movements as a distance to move along each axis.


  
    Left-handed vs. right-handed coordinates


    The positive and negative direction of each axis is arbitrary, and the coordinates still work no matter in which direction the axes point. You simply need to maintain consistency within a given 3D graphics tool (animation tool, game development tool, and so forth).


    



    But in almost all cases, x goes to the right and y goes up; what differs between different tools is whether z goes into or comes out of the page. These two directions are referred to as left-handed or right-handed; as this figure shows, if you point your thumb along the x-axis and your index finger along the y-axis, then your middle finger points along the z-axis.
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    The z-axis points in a different direction on the left hand versus the right hand.


    



    Unity uses a left-handed coordinate system, as do many 3D art applications. Many other tools use right-handed coordinate systems (OpenGL, for example), so don’t get confused if you ever see different coordinate directions.

  


  Now that you have a plan in mind for this project and know how coordinates are used to position objects in 3D space, it’s time to start building the scene.


  
2.2 Begin the project: Place objects in the scene


  Let’s create and place objects in the scene. First, you’ll set up all the static scenery—the floor and walls. Then you’ll place lights around the scene and position the camera. Lastly, you’ll create the object that will be the player, the object to which you’ll attach scripts to walk around the scene. Figure 2.5 shows what the editor will look like with everything in place.
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  Figure 2.5 Scene in the editor with floor, walls, lights, a camera, and the player


  Chapter 1 showed how to create a new project in Unity, so you’ll do that now. Choose New in Unity Hub (or File > New Project in the editor) and then name your new project in the window that pops up. The scene starts out mostly empty, and the first objects to create are the most obvious ones.


  
2.2.1 The scenery: Floor, outer walls, and inner walls


  Select the GameObject menu at the top of the screen and then hover over 3D Object to see that drop-down menu. Select Cube to create a new cube object in the scene (later, we’ll use other shapes, like Sphere and Capsule). Adjust the position and scale of this object, as well as its name, to make the floor. Figure 2.6 shows which values the floor should be set to in the Inspector (it’s a cube only initially, before you stretch it out).


  NOTE You can think about the numbers for position in terms of any units you want, as long as you’re consistent throughout the scene. The most common choice for units is meters, and that’s what I generally choose, but I also use feet sometimes, and I’ve even seen other people decide that the numbers are inches!


  Repeat the same steps to create outer walls for the room. You can create new cubes each time, or you can copy and paste existing objects by using the standard shortcuts. Move, rotate, and scale the walls to form a perimeter around the floor. Experiment with different numbers (for example, 1, 4, 50 for Scale) or use the transform tools introduced in section 1.2.2 (remember that the mathematical term for moving and rotating in 3D space is transform).


  TIP Recall the navigation controls in chapter 1 to view the scene from different angles or zoom out for a bird’s-eye view. If you ever get lost in the scene, press F to reset the view on the currently selected object.
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  Figure 2.6 Inspector view for the floor


  Once the outer walls are in place, create inner walls to navigate around. Position the inner walls however you like; the idea is to create hallways and obstacles to walk around once you write code for movement. The exact Transform values that the walls end up with will vary depending on how you rotate and scale the cubes to fit, and on how the objects are linked together in the Hierarchy view. If you need an example to copy working values from, download the sample project and refer to the walls there.


  TIP Drag objects on top of each other in the Hierarchy view to establish linkages. Objects that have accompanying objects attached are referred to as parents; objects attached to parent objects are referred to as children. When the parent object is moved (or rotated or scaled), the child objects are transformed along with it.


  Definition A root object (closely related to the concepts of parent and child objects) is an object at the base of a hierarchy that does not itself have a parent. Thus, all root objects are parents, but not all parents are root objects.


  You can also create empty game objects to use for organizing the scene. From the GameObject menu, choose Create Empty. By linking visible objects to a root object, their Hierarchy list can be collapsed. For example, in figure 2.7, the walls are all children of an empty root object (named Building) so that the Hierarchy list will look organized.
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  Figure 2.7 The Hierarchy view showing the walls and floor organized under an empty object


  Warning Before linking any child objects to it, make sure to reset the Transform options (Position and Rotation to 0, 0, 0 and Scale to 1, 1, 1) of the empty root object to avoid any oddities in the position of child objects.


  
    What is GameObject?


    All scene objects are instances of the GameObject class, similar to the way all script components inherit from the MonoBehaviour class. This fact was more explicit with the empty object actually named GameObject, but is still true regardless of whether the object is named Floor, Camera, or Player.


    



    GameObject is really a container for a bunch of components. The main purpose of GameObject is to provide MonoBehaviour something to attach to. What exactly the object is in the scene depends on which components have been added to that GameObject. Cube objects have a Cube component, Sphere objects have a Sphere component, and so on.

  


  Remember to save the changed scene if you haven’t yet. Now the scene has a room in it, but we still need to set up the lighting. Let’s take care of that next.


  
2.2.2 Lights and cameras
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